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Precautions and Disclaimers
 z Precautions regarding security

When using the Geometric & Setup Management Software (Geometry Manager Pro), security breaches of the type described 
below are conceivable.

 z Leakage of your private information via this software
 z Illegal operation of this software by a malicious third-party
 z Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
 z Make sure the password is as hard to guess as possible.
 z Change the password periodically.
 z Panasonic Corporation and its affiliated companies never directly ask customers for their password. Do not give out your 
password even if directly asked by a third-party representing themselves as Panasonic Corporation.

 z Always use on a network that has safety protection such as a firewall implemented.
 z Set the password for the computer you are using in order to set limits on user accessibility.

 z This software makes use of the following software. 
A portion of this software is based in part on the work of the Independent JPEG Group.

 z The illustrations and display examples used in this manual may differ from the actual product.

 z Panasonic cannot be held liable for damages arising from data corruption or loss as a result of using this projector.
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What You Can Do with Geometry Manager Pro
Using this software allows you to perform real-time geometric compensation and other fine adjustments and corrections that 
cannot be handled on the projector side.
Even when using this software, however, some functions and expanded functions may not be available unless the projector is 
activated.

 “Activation” (page 12)
 “Functions which are expanded as a result of activation” (page 15)

 � Geometry correction
When projecting images onto a screen surface that is not perfectly flat (such as the 
wall of a building) or projecting them onto a screen surface at an angle, the images 
become distorted.
When projecting images in these kinds of special environments, the geometry 
correction function serves to correct the images to counter the shape of the screen 
surface.

 � Edge blending
This function serves to correct the brightness and makes the joins between the 
images less visible when the images projected from a multiple number of projectors 
are combined to form a single image.

 � Uniformity
This function makes it possible to correct color irregularities in projected images 
– for example, those resulting from irregularities in the screen surface or from 
surrounding light and shade.

 � Masking
This function makes it possible to mask certain parts of the projected images, 
projecting only the required parts.

 � Auto Screen Adjustment (AUTO ADJUST)
This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the 
shape of the screen through use of a camera.

Note
 z Both Geometry Manager Pro and the Geometry Manager Pro - Auto Screen Adjustment plug-in software must be 
installed to use the Auto Screen Adjustment function.

 z To use the Auto Screen Adjustment function, prepare a camera separately.  “Camera connection” (page 77)

 � Other functions
The lens, color matching and input signal can all be adjusted.
Some of the projector’s menu operations can also be carried out on a computer screen.
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Check Your Computer

System requirements
The computer must meet the following requirements in order to use the supplied software.

OS: Microsoft Windows 7  Ultimate 32/64bit, Professional 32/64bit
   Home Premium 32/64bit 
 Windows 8   Windows 8 32/64bit, Windows 8 Pro 32/64bit
 Windows 8.1  Windows 8.1 32/64bit, Windows 8.1 Pro 32/64bit
 Compatible with English, Japanese or Chinese language versions of the above operating systems.
 • Compatible with Windows 7 up to SP1.
  • For a 64bit OS, this application runs on WOW64.
CPU: Clock speed of 1 GHz or higher
Memory: 2 GB or more
Available disk space:
 16 GB or greater (Further available space is necessary to save projector information)
Other requirements:
  A display with a resolution of 1 024 × 768 pixel or higher using High Color (16 bit) or higher 
  LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T) or a serial port (RS-232C compliant)
  USB2.0-compatible port or higher (when using the Auto Screen Adjustment function)

Note
 z A LAN connector is required to use the Auto Screen Adjustment function.
 z Please understand that operation is not guaranteed if this software application is used in a system environment other than 
that specified above or on a home-built computer.

Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected
Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.

Computer with a built-in LAN function
 z Is your LAN switched on?

Computer without a built-in LAN function
 z Is your LAN adapter properly recognized? 
Please install the LAN adapter driver beforehand. 
For details on how to install the driver, please refer to instructions accompanying the LAN adapter.

 z Is your LAN adapter switched on?

Note
 z It may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN 
adapter are installed.  

 “Frequently Asked Questions” (page 89)
 z Operation is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.
 z An Internet connection is required to activate a projector.
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Installing/Uninstalling Software

Installation
Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing Geometric & Setup Management Software (Geometry Manager Pro)

1 Download the software.

 z Download Geometry Manager Pro.  
Click [Software Download] on the top page of the Panasonic website (http://panasonic.net/avc/projector/pass/), and 
follow the on-screen instructions to download the software.

Note
 z To download this software, you must be a registered PASS*1 member and log into the PASS server (http:// panasonic.
net/avc/projector/pass/). 
*1   PASS stands for “Projector Asset Support System.” 

The system will be referred to by this abbreviation in this manual.
 z To enable use of the Auto Screen Adjustment function, download the Auto Screen Adjustment plug-in software as 
well.

 “Installing the Auto Screen Adjustment plug-in software” (page 8)

2 The installer starts up.

Double-click the downloaded “Installer.exe” file.

Follow the on-screen instructions to install the application.

3 As soon as the installation process is completed, a shortcut icon is created on the desktop.

Note
If an identical version of the software is already installed, the following screen for selecting whether to repair or remove the 
existing version appears.
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Installing/Uninstalling Software  Installation

 � To repair defects in the software, select “Repair Geometry Manager Pro”, and click [Finish].  
To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro], and 
click [Finish].

 � If you selected [Repair Geometry Manager Pro] and the “Insert disk” message is displayed, uninstall the 
application, and then reinstall it.

Installing the Auto Screen Adjustment plug-in software

1 Download the Auto Screen Adjustment plug-in software.

 z Both Geometry Manager Pro and the Geometry Manager Pro - Auto Screen Adjustment plug-in software are 
necessary to use the Auto Screen Adjustment function.  
Click [Software Download] on the top page of the Panasonic website (http://panasonic.net/avc/projector/pass/), and 
follow the on-screen instructions to download the Auto Screen Adjustment plug-in software.

2 The installer starts up.

Double-click the downloaded “AusInstaller.exe” file, and follow the on-screen instructions to install the application.

Note
The compatible combination of versions for the Auto Screen Adjustment plug-in software and the Geometry Manager Pro 
software is predetermined. Therefore, an error message will appear if you attempt to install an incompatible version of 
the Auto Screen Adjustment plug-in software. In such cases, check whether the version of Geometry Manager Pro that 
appears in the error message matches the software version found on the above website. If the versions match, download 
and install only Geometry Manager Pro from the website. If the versions do not match, download and install both Geometry 
Manager Pro and the Auto Screen Adjustment plug-in software.

3 When installation is complete, the [AUTO ADJUST] (Auto Screen Adjustment) button at the top right of the 
Geometry Manager Pro main screen will be enabled.
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Installing/Uninstalling Software  Software Uninstall

Software Uninstall

Windows 7
Select [Geometry Manager Pro] from [Start] → [Control Panel] → [Uninstall a program], and click [Uninstall].

Windows 8 / Wimdows 8.1
Press [X] while holding down the [Windows logo] key on the keyboard. Select [Geometry Manager Pro] from [Control Panel] → 
[Uninstall a program], and click [Uninstall].

Note
Uninstalling Geometry Manager Pro will not uninstall the Auto Screen Adjustment plug-in software. Perform the same 
procedure as the above to uninstall the Auto Screen Adjustment plug-in software (Geometry Manager Pro - Auto Screen 
Adjustment plug-in).
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Preparation
There are two ways to connect the computer to the projector. One uses a LAN connection and the other uses a serial 
connection.
Projectors connected via a LAN connection and projectors connected via a serial connection cannot be corrected or adjusted 
at the same time.

 � Projectors supported
For details on models compatible with Geometry Manager Pro, check the information found on software download page of the 
Panasonic website (http://panasonic.net/avc/projector/pass/).

Note
No guarantees are made for the operations when the computer is connected to a non-supported projector.

 � LAN connection
Connect the projector and computer using a LAN cable.
Up to 64 projectors can be connected. When using the Auto Screen Adjustment function, up to 48 of these projectors can be 
adjusted at the same time.

 � Serial (RS-232C) connection
Connect the projector to the computer on a 1:1 basis using a serial cable.
Use a cable complying with the RS-232C standard as the serial cable.

Note
 z For the types of cables that can be used, refer to the operating instructions of the projector.
 z Use a LAN connection when using the Auto Screen Adjustment function.  
Auto Screen Adjustment cannot be performed via a serial (RS-232C) connection. 

 “Auto Screen Adjustment” (page 77)

 � Setting the Computer
1 Please use a crossing cable to connect the computer and projector when it is directly connected to the LAN.  

When connecting via a hub, for example, use a straight cable.

2 Network Setup

 z Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment. 
(Please consult your network administrator for details.)

 z If “use of automatic script” is checked for your web browser, please uncheck.
 z If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to 
“Exceptions” in the detailed proxy settings.

Note
Depending on the system configuration, whether it is straight, cross, or both to be used, will differ. 
Please consult your network administrator for details.
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Preparation 

 � Setting the Projector
Network Setup

Set the PROJECTOR NAME (HOST NAME), IP ADDRESS, SUBNET MASK, and DEFAULT GATEWAY according to the 
operating environment. (Please consult your network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on 
the LAN.
If the entered IP address is used by another device, the projector cannot be registered.

 z For models that can be set, enable both WEB Control and Command Control.
 z For models in which the Web port number can be set, set the port number to “80”.

Note
 z Refer to operating manual of the projector for method on configuring the projector.
 z This software identifies the projector using the configured IP address. If DHCP is set to ON in the projector network setting 
in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the 
projector, making it impossible to connect using this software. 
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP 
address allocated to the projector. (Please consult your network administrator for details.)

 � Activation
Activating a projector enables and expands certain functions.
The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for activation. For details on 
compatible projector models, check the information found on the activation page of the Panasonic website (http://panasonic.
net/avc/projector/pass/).

 “Functions which are expanded as a result of activation” (page 15)

Note
The Auto Screen Adjustment plug-in software must be installed and the Auto Screen Adjustment upgrade kit (ET-CUK10) must 
be applied on the projector to enable the Auto Screen Adjustment function.

 � Camera connection
To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen 
Adjustment” (page 77).
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Activation
Activating a projector enables and expands certain functions.
The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for activation. For details on 
compatible projector models, check the information found on the activation page of the Panasonic website (http://panasonic.
net/avc/projector/pass/).

 “Functions which are expanded as a result of activation” (page 15)

Note
Both Geometry Manager Pro and the Auto Screen Adjustment plug-in software must be installed to use the Auto Screen 
Adjustment function.

Perform the projector activation
The flow of operations from installation to activation is as follows.
This section describes the activation procedure.

Key code

Device 
information file

Software installation

Activation code

Activation code

Device information file

ACTIVE.LST

SERIAL.LST

1 Have the key code ready.

The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit 
(ET-CUK10).
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Activation  Perform the projector activation

2 Start the software application, and display the main screen.

 “Adjustment and Settings – Main screen” (page 18)

3 On the [File] menu, select [Activation] – [Export Equipment Profile].
 z All the projectors to which the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10) is not 
applied will be targets for operation.

 z All connected projectors will be displayed in the common operation area. However, the operation cannot be performed 
while two or more of these projectors are selected.

 z In the common operation area, an asterisk (*) appears to the left of projector names for which the upgrade kit (ET-UK20) 
has not been applied. You can check whether the upgrade kit (ET-CUK10) is applied when using the Auto Screen 
Adjustment function.

The file save screen is displayed.

4 Specify the save destination, name the file, and save.

 z The default file name is “SERIAL.LST.”

When the confirmation screen for saving the file appears, click [OK].

5 Start the web browser, and log into the PASS server (http://panasonic.net/avc/projector/pass/).

6 Click the activation button in the side menu of the top page, and follow the on-screen instructions to perform key 
code registration, etc.

Register the key code readied in step 1 and the file (default file name: SERIAL.LST) saved in step 4 to the PASS server to 
acquire the activation code file (default file name: ACTIVE.LST).

 z The activation codes for the upgrade kit (ET-UK20) and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be 
acquired separately.

7 Close the web browser.
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Activation  Perform the projector activation

8 On the File submenu, select [ET-UK20] or [ET-CUK10] under [Activation] - [Projector Activation].

The file selection screen is displayed.

9 Select the activation code file (default file name: ACTIVE.LST) acquired in step 6.
When activation is complete and the confirmation screen appears, click [OK].
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Activation  Functions which are expanded as a result of activation

Functions which are expanded as a result of activation
Listed below are the functions which are expanded when the activation process has been completed.

 � Upgrade kit (ET-UK20)
Function Activation not completed Activation completed

Grid pattern

When the resolution of the projector 
is 1920x1200 dots

2×2 to 11×11 2×2 to 41×26

When the resolution of the projector 
is 1400x1050 dots

2×2 to 11×11 2×2 to 29×22

Geometry 
Correction

Adjustment 
ranges

Vertical keystone 
correction

 ±40°  ±45°

Horizontal keystone 
correction

 ±15°  ±40°

Vertical arcs ±50 ±100
Horizontal arcs ±50 ±100

Rotational correction – √
Flip Vertical
Flip Horizontal

– √

Uniformity
Flexible Correction – √

Flip Vertical
Flip Horizontal

– √

Masking – √

  √ : Can be used.
  – : Cannot be used.

 � Auto Screen Adjustment upgrade kit (ET-CUK10)
This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape 
of the screen through use of a camera.

Note
 z Both Geometry Manager Pro and the Auto Screen Adjustment plug-in software must be installed to use the Auto Screen 
Adjustment function.

 z To use the Auto Screen Adjustment function, prepare a camera separately.  “Camera connection” (page 77)
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Starting and Exiting the Application

Starting the application
Double-click the shortcut icon on the desktop.
When the application starts, the connection settings screen appears.

LAN connection

Serial (RS-232C) connection

To use a LAN connection for the projector and computer, select [  ]; alternatively, to use a serial (RS-232C) 
connection, select [  ].

The following items can be selected from the [Option] menu at the top left of the connection settings screen.
Service Password

This menu is used to support maintenance by Panasonic. It is not normally used.
Version

This is where the application’s version information can be checked.

 � LAN connection

Place a check mark in [  ], and perform the following settings.

IP Address
Input the IP address of the projector to be connected to the computer.

Port
Set the number of port on the computer for connecting with the projector.

User Name
Input the user name used for WEB control of the connected projector.

Password
Input the password used for WEB control of the connected projector.

After performing the settings, click [OK] to display the main screen.  “Adjustment and Settings – Main screen” (page 18)
When [Exit] is clicked, the application is exited without establishing a connection.
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Starting and Exiting the Application  Exiting the application

 � Serial (RS-232C) connection

Place a check mark in [  ], and perform the following settings.

Projector ID
Select [All] or [1] to [64].
If [All] has been selected, all the projectors with [All] set for [Projector ID] and [On] set for [Response (ID All)] can be 
used.
When a number from [1] to [64] has been selected, the projectors set to the same ID ([1] to [64]) can be used.
For the [Projector ID] and [Response (ID All)] settings, refer to the Operation Manual of the projector.

Port
The ports which can be used on the computer are displayed here.

Baud Rate
Set the baud rate from the speeds given below:

 z 9600 bps
 z 19200 bps
 z 38400 bps

Parity
Set the parity used for the parity check here:

 z NONE: No parity
 z ODD: Odd parity
 z EVEN: Even parity

After performing the settings, click [OK] to display the main screen.  “Adjustment and Settings – Main screen” (page 18)
When [Exit] is clicked, the application is exited without establishing a connection.

Note
The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied.

Exiting the application
To exit the connection main screen, either select [File] and then [Exit] or click the  button at the top right of the window. 
To exit the connection settings screen, either click the [Exit] button or click the  button at the top right of the window. 
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Adjustment and Settings

Main screen
The main screen consists of the following five general areas and the AUTO ADJUST (Auto Screen Adjustment) button.

Main menu

Icon menu

Adjustment area

Common operation area

Status bar

AUTO ADJUST (Auto Screen 
Adjustment) button

Note
 z When using this application, keep the main power of the projector in the “on” setting. 
If the standby mode is set to [Normal], the [Power ON] operation is enabled even when the projector is in standby mode. 
However, if the standby mode is set to [ECO], all operations including [Power ON] will be disabled. When using this 
application and performing the [Power ON] operation, set the projector’s standby mode to [Normal]. Operations other than 
[Power ON] are not guaranteed, when the standby mode is set to [Normal].

 z If the projector settings have been changed using a remote control, for instance, rather than the software application, the 
software application displays and projector settings may not match.

Adjustment area
You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The modes in which these adjustments and operations are performed are called “editing modes.”
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Adjustment and Settings  Main screen

Main menu

 � File submenu
Open File (Current Tab)

This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the 
computer.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Open File (One Projector)

This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected 
projector.

When this menu item is selected, the loaded settings are reflected in the target projector even if  (at the 
bottom of the common operation area) has not been checked. 

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as 
the one when the setting file was saved.

Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target projectors that are connected even if 

 (at the bottom of the common operation area) is not checked.
 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message. 

Note
 z When the file is loaded, an error message is displayed if the target projector is not connected to the network. When 
the connection of the target projector to the network is recognized, the connection is established and the loaded 
settings are reflected automatically. 

 z This function cannot be used for a serial (RS-232C) connection.

Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.

Save File (One Projector) As... 
This saves the settings now being edited in a file under the filename (with .prj extension) provided.

Save File (All Projectors) As... 
This saves the setting information of all the currently connected projectors as a single All Project File (with .prjs 
extension) on the computer.
The layout information, IP addresses, user names, and passwords of the projectors are also encrypted and saved in the 
All Project File.

Note
This function cannot be used for a serial (RS-232C) connection.

Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Reload (Current Tab)
This cancels the settings currently being edited using the application, and loads the same settings again from the 
projector.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
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Adjustment and Settings  Main screen

Activation 
Export Equipment Profile
Creates a file to be registered in the PASS server. This file is required to acquire the activation code file.

 “Activation” (page 12)

Projector Activation (ET-UK20 / ET-CUK10)
Select [ET-UK20] or [ET-CUK10], and perform projector activation.

 “Functions which are expanded as a result of activation” (page 15)
 z The activation code file is required.

 “Activation” (page 12)
 z If the Auto Screen Adjustment plug-in software is not installed, [ET-CUK10] cannot be selected.

 “Installing the Auto Screen Adjustment plug-in software” (page 8)

Export
Multi Projector Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Projector Monitoring & Control Software”.
The file is for registering the data of the projectors already registered in the software application in the “Multi Projector 
Monitoring & Control Software” for monitoring and control purposes.
For details, refer to the operation manual of the “Multi Projector Monitoring & Control Software”.

Note
This function cannot be used for a serial (RS-232C) connection.

Exit
Exits the software.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

 � Edit submenu
Undo

This discards the software application and projector settings currently being edited.
It returns these settings to the status before the setting data is sent.

Redo
This returns the settings to the ones before the Undo operation is performed.

Note
 z Undo and Redo can be used up to 8 times during a single setting process (for each editing mode).
 z The Undo and Redo logs are cleared if you switch to another editing mode or projector.
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Adjustment and Settings  Main screen

The following Edit submenu items are enabled only in certain editing modes. For details, refer to the respective reference 
pages.

Lock
 “Adjustment and Settings − Geometry Correction” (page 32)

Unlock
 “Adjustment and Settings − Geometry Correction” (page 32)

Free
 “Adjustment and Settings − Geometry Correction” (page 32)

Reset
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Uniformity” (page 52), 
“Adjustment and Settings − Masking” (page 62) 

Flip Vertical
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Uniformity” (page 52), 
“Adjustment and Settings − Masking” (page 62) 

Flip Horizontal
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Uniformity” (page 52), 
“Adjustment and Settings − Masking” (page 62) 

Area Select
 “Adjustment and Settings − Uniformity” (page 52)

Point Select
 “Adjustment and Settings − Uniformity” (page 52)

 � View submenu
Tool Bar
Status Bar
Sub Window
Layout Window

Enter a check mark, and select whether the items are to be displayed.
In the initial status, [Tool Bar] and [Status Bar] are displayed.

Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the 
projector as soon as they are changed.

Line Color
White / Red / Green / Blue
These perform the same operations as the icon menu [White], [Red], [Green] and [Blue] on the Geometry screen.

 “Adjustment and Settings - Geometry Correction - Geometry screen” (page 33)

Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.

 “Adjustment and Settings - Main screen - Coordinate Information” (page 28)
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Adjustment and Settings  Main screen

Grid Resolution
Use Square Grid / X / Y
These select the mode in which the coordinates of the control points are displayed.

 “Adjustment and Settings - Geometry Correction - Geometry screen” (page 33)

Zoom
x1/4 / x1/2 / x1 / x2 / x3 / x4 / x5 / x6 / x7 / x8
The editing area is zoomed in or out.

Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.

 “Adjustment and Settings - Masking Masking screen” (page 62)

 � Tools submenu
Auto Screen Adjustment

This displays the Auto Screen Adjustment screen.
This performs the same operation as the [AUTO ADJUST[ (Auto Screen Adjustment) button.

 “AUTO ADJUST (Auto Screen Adjustment) button” (page 29)

Note
This cannot be selected if the Auto Screen Adjustment plug-in software is not installed.

 � Version submenu
About Geometry... 

This displays version information for Geometry Manager Pro.

Icon menu
This icon menu is used in all the editing modes.
For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.

 Open File (One Projector)

This performs the same operation as [Open File (One Projector)] on the File submenu.

 Save File (One Projector)

This performs the same operation as [Save File (One Projector)] on the File submenu.

 Reload (Current Tab)

This performs the same operation as [Reload (Current Tab)] on the File submenu.

 Undo

This performs the same operation as [Undo] on the Edit submenu.

 Redo

This performs the same operation as [Redo] on the Edit submenu.
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 Layout Window

Each time this is clicked, the Layout Window screen is switched between displayed and cleared.
On the Layout Window, the positions of the projectors can be changed by means of mouse operations.
When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved.
Main screen operations can be performed even while the Layout Window is displayed.
The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu.
The Layout Window screen below is an example when eight projectors are connected.

Selection area
The projector layout is displayed.
Changing the layout or double-clicking the frame of a different projector 
causes that projector to be selected.
The frame of the selected projector is indicated in red.

OK
Click to apply the layout displayed in the selection area and close the 
screen.

Cancel
Click to close the screen without applying the layout displayed in the 
selection area.

Apply
Click to apply the layout displayed in the selection area.
The screen is not closed.

 Reset Data (Current Tab)

This performs the same operation as [Reset Data (Current Tab)] on the File submenu.

 Open File (Current Tab)

This performs the same operation as [Open File (Current Tab)] on the File submenu.
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Common operation area
The common operation area houses the operations which can be used in all the editing modes.

Projector list
This list displays the projector numbers, projector names and IP addresses (with 
the LAN connection) or COM port numbers (with serial RS-232C connection) in the 
sequence in which the projectors were connected.
The projector currently selected is the one whose data is being edited. Any projector on 
the list can be selected to switch the projector whose data is to be edited.

Note
 z Multiple projectors can be selected as targets for operations by holding the Ctrl key 
while clicking. In that case, the following functions can be operated. 
Power ON/Standby, Shutter ON/Shutter OFF, Status ON/Status OFF, Status Page, 
Test Pattern, Display Projector Name, Grid Resolution, Display Grid Lines

 z When a projector for which the upgrade kit (ET-UK20) has not been applied is 
connected, an asterisk (*) appears to the left of that projector name. An error 
message will appear if you connect to this projector and attempt to use the extended 
functions.  “Activation” (page 12)

 z When a projector on the list is selected and then double-clicked, the WEB control 
screen opens. For details on the WEB control screen, refer to the operating 
instructions of the projector.

 z When the mouse pointer is placed over a projector on the list, a tooltip appears and 
shows the model number and resolution of that projector..

Del
Click to remove the selected projector from the operating targets. 
When all the projectors are removed, the software is exited.
This cannot be selected if the serial connection is used for the projectors.

Add
Click to display the LAN connection destination selection screen and add a new 
projector.

   “Adjustment and Settings − Main screen − LAN connection destination selection 
screen”(page 25)

 z It cannot be selected if the serial connection is used for the projectors.

Rename
Click to change the name of the currently selected projector.
A name can consist of a maximum of 12 characters including letters (upper-case), 
numbers, hyphens and periods.

Display Projector Name
Click to display the name and number of the currently selected projector on the image 
projected by the projector.
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LAN connection destination selection screen
When  is clicked, the LAN connection destination selection screen is displayed.
A projector that is going to be connected now be set.

IP Address
Input here the IP address of the projector to be connected.

Port
Set here the number of the port that is to be connected to the projector.

User Name
Input here the user name of the projector to be connected.

Password
Input here the password of the projector to be connected.

Exit
Click to cancel the connection with the projector and close the LAN 
connection destination selection screen.

OK
Click to make the connection with the projector using the data which has 
been input.
When the projector is connected successfully, the LAN connection 
destination selection screen is closed.
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Power ON/Standby
Click the left button to set the power of the selected projector to the “On” state or click the 
right button to set it to the standby state. 
The setting is reflected in the projector even when a check mark has not been entered in 

.

Note
When the projector is in the standby state, no guarantees are made for any operations 
except [Power ON].

Shutter ON/Shutter OFF
Click the left button to set the shutter of the selected projector to the “On” state or click 
the right button to set it to the “Off” state.
The setting is reflected in the projector even when a check mark has not been entered in 

.

Status ON/Status OFF
Click these to select to display (ON) or not display (OFF) the status (information) on the 
images of the selected projector.
The setting is reflected in the projector even when a check mark has not been entered in 

.

Test Pattern
Click to switch the image projected from the projector to the test pattern. 
Any of the following test patterns can be selected.

OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow, Window, Window 
(Inversion), Color Bars (Vertical), Color Bars (Horizontal), 16:9 / 4:3, Focus (White), 
Focus (Red), Focus (Green), Focus (Blue), Focus (Cyan), Focus (Magenta), Focus 
(Yellow)

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in 

.

Status Page
Click these to select the previous or next page of the status screen when the status is 
displayed on the projector’s image.
The setting is reflected in the projector even when a check mark has not been entered in 

.
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Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

When a check mark is entered for  , the two grid resolutions 
(horizontal and vertical) become one, and the button for selecting the combination of the 
number of grids whose horizontal and vertical intervals are identical is selected.
Any of the following numbers of square grids can be selected.

If the projector resolution is WUXGA:
41×26*, 33×21*, 25×16*, 17×11*, 9×6

If the projector resolution is SXGA+:
29×22*, 21×16*, 9×7, 5×4

*   Selectable if the upgrade kit (ET-UK20) has been applied to the projector. 
  “Activation” (page 12)

Grid Resolution (vertical)
The number of grids in the vertical direction is selected here.
Any of the numbers of grids listed below can be selected.

If the projector resolution is WUXGA:
Horizontal: 2 to 41*1 (2 ~ 11)*2 (default value: 11)
Vertical: 2 to 26*1 (2 ~ 11)*2 (default value: 11)

If the projector resolution is SXGA+:
Horizontal: 2 to 29*1 (2 ~ 11)*2 (default value: 11)
Vertical: 2 to 22*1 (2 ~ 11)*2 (default value: 11)

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected 
projector.

*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected 
projector.  

 “Activation” (page 12)

Display Grid Lines
The color of the grids to be projected is selected here.

OFF, White, Red, Green, Blue, Cyan, Magenta, Yellow

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in 

.
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Coordinate Information
The mode in which to display the control point coordinates is selected here when grids 
have been set in one of the editing modes.

None: The coordinates are not displayed.
Absolute:  The coordinates with the top left control point used as the origin point are 

displayed alongside the control points.
Relative:  The coordinates with the initial position of the control point in the selected 

grid used as the origin point are displayed alongside the control points.

Note
However, if the grid intervals are narrow, the coordinates may not be displayed even 
when Absolute or Relative has been selected.

Manual Transfer
When this button is clicked, the edited settings are reflected in the projector.

When a check mark is entered in  , as soon as a setting is changed, that 
setting is reflected in the projector.

Cursor Information
When a check mark is entered for , the cursor indicating the position of the 
control point can be displayed on the projected image.

Note
The cursor appears only at the top left when the control point has been selected using a 
line or area. 
If a multiple number of control points have been selected, the cursor will be displayed 
only at the control point selected last.

Cursor
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AUTO ADJUST (Auto Screen Adjustment) button
This allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the 
screen through use of an externally connected camera.

 “Auto Screen Adjustment” (page 77)

[AUTO ADJUST] button
Click the button to display the Auto Screen Adjustment screen.

Note
If the Auto Screen Adjustment plug-in software has not been installed, the 
[AUTO ADJUST] button will be disabled.

 “Installing the Auto Screen Adjustment plug-in software” (page 8)

Status bar
This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.
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Lens Settings

Lens setting screen
The lens settings are selected on this screen.

②

⑦

⑧

⑨

⑩

① ③ ④ ⑬

⑤

⑥

⑫ ⑪ ⑭

① Upward
Use this to move the projected image upward.

The image moves in small steps using  , in larger steps using  and in even larger steps using .

② Leftward
Use this to move the projected image toward the left.

The image moves in small steps using  , in larger steps using  and in even larger steps using .

③ Rightward
Use this to move the projected image toward the right.

The image moves in small steps using  , in larger steps using  and in even larger steps using .

④ Downward
Use this to move the projected image downward.

The image moves in small steps using  , in larger steps using  and in even larger steps using .

⑤ Home Position
Click to move the lens position to the home position.

⑥ Lens Calibration
Click to automatically set the limit to which the lens is to be moved and the home position of the lens.



31

Adjustment and Settings  Lens Settings

⑦ Lens Focus (Far)
Click these buttons to adjust the focus to “far”.
The further toward the left the button is located, the further the focus will move.

⑧ Lens Focus (Near)
Click these buttons to adjust the focus to “near”.
The further toward the right the button is located, the closer the focus will move.

⑨ Lens Zoom (Tele)
Click these buttons to reduce the size of the projected image (zoom out). 
The image is reduced in progressively larger steps by clicking the buttons progressively further toward the left.

⑩ Lens Zoom (Wide)
Click these buttons to enlarge the size of the projected image (zoom in).
The image is enlarged in progressively larger steps by clicking the buttons progressively further toward the right.

⑪ Lens Memory Save
Click these buttons to save the focus position, shift position and zoom position of the adjusted lens in the projector. 
There are three lens memories in which the settings can be saved (default names: LENSMEMORY1, LENSMEMORY2 
and LENSMEMORY3).

Even if a check mark has not been entered for  , the settings are saved in the lens memory when the 
[Save] button is clicked.
This function can be used only for projectors that have this function. 

⑫ Lens Memory Load
Click these buttons to select and load the lens memory whose settings are saved in the projector.
The lens will move automatically to the saved focus position, zoom position and shift position.

Even if a check mark has not been entered for  , the settings are loaded from the lens memory when the 
[Load] button is clicked.
This function can be used only for projectors that have this function. 

⑬ Lens Memory Rename
Click these buttons to rename the lens memory settings.
When one of the buttons is clicked, the [Rename] screen is displayed.

When a new name is input and the [OK] button is clicked, the [Rename] screen is closed, and the name of the projector’s 
lens memory settings is changed.
If the [Cancel] button is pressed instead, the [Rename] screen is closed without renaming the lens memory settings.
This function can be used only for projectors that have this function. 

⑭ Lens Memory Delete
Click these buttons to delete the settings saved in the lens memory of the projector.

Even if  Transfer is not checked, the settings are deleted from the lens memory when the [Delete] button 
is clicked.
This function can be used only for projectors that have this function. 
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Geometry Correction
Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected. 
By adjusting the number of grids or number of control points, the images can be made to look more natural. 
Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine 
corrections. 

 z Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical 
direction. 

 z Select the control point and then press the cursor key while holding down the Ctrl key to move it in increments of 0.2 pixel.

Note
When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost.
It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of 
grids be displayed to make fine adjustments.

Selecting the control points
Select the Geometry screen and switch the mode to other than OFF. The control points can now be selected.

 “Free Grid (Free-form correction)” (page 35)
Drag the control points to move them. The control points cannot be moved by selecting the lines.

A multiple number of control points can be selected 
by dragging and enclosing the points where the grids 
intersect.

The control points can be selected using lines by 
clicking the space between one point where the grids 
intersect and another such point.

The control points can be selected using a multiple 
number of lines by dragging and enclosing the 
spaces between one point where the grids intersect 
and another such point.

When a point where the grids intersect is clicked, it 
can be selected as a single control point.

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected 
control point keeps selected.
To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or 
press the cursor key while holding down the Shift key.
To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit 
submenu displayed by right-clicking.

Right-clicking
The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse 
is clicked.
All of the operations from the the [Edit] menu are available.

 “Edit submenu” (page 33).

Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal



33

Adjustment and Settings  Geometry Correction

Geometry screen

The following menu items can be used on the Geometry screen.

 � Edit submenu
Lock

Locks the control points of the grids selected.

Note
A locked control point will not move even if the correction pattern has been changed.  
The lock will not be released even if the number of grids has been changed.

Unlock
Unlocks the control points that have been selected.

Free
Click to release the control point selection.

Reset
Click to return the selected control points to the initial status.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

 � View submenu

Grid Resolution
Use Square Grid
This makes it possible to select the combination of the number of grids which can be selected when a check mark 

has been entered for  in the common operation area.

X
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.

Y
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
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①②③④ ⑤

⑥

⑦

① Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
z This performs the same operation as [Sub Window] of the View submenu.
z The red frame around the Sub Window indicates the display range in the editing area.

② Zoom In
Zooms in to the editing area.

③ Zoom Out
Zooms out the editing area.

④ White
This corrects the RGB color components together.

⑤ Red, Green, Blue
These correct only the component of the selected color.

⑥ Editing Area
The image can be corrected by selecting the grid using the mouse.
The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected. 

⑦ Operation Area
This is where the buttons, slide bars, etc. used by geometry correction are displayed. 
The operations that they perform differ depending on which correction pattern has been selected.
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Free Grid (Free-form correction)
The Free Grid operation area is where the operations for all the correction patterns are selected.
The corrections made with Free Grid are also reflected in the editing area of the other correction patterns.

①

⑦

② ③ ④ ⑤ ⑥

① Mode Switching
OFF: Disables geometry correction.
PC1 / PC2 / PC3: Enables geometry correction.

Note
When geometry correction is enabled, only one piece of data (PC) can be saved for some models. 

② Moving Area
Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.

③ Smoothing
Correction using curves can be performed when a check mark is entered in .

Example when the check mark is entered Example when the check mark is not entered

④ Alert Distortion
If a setting exceeding the geometric distortion limit is sent to the projector when  has been checked, an 
error message will be displayed on the dialog screen. The error message will be displayed on the status bar if a check 

mark has been entered in .
A check mark is entered as the default setting.

When a check mark is not entered for  , even settings exceeding the geometry correction limits can be 
sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.
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⑤ Store
Click this button to save the current settings inside the projector after they have been reflected in the projector.

Note
A screen for selecting the save folder inside the projector may appear for some models. 

⑥ Display Switching
Click  to minimize the operation area; conversely, click  to maximize it.

⑦ Correction Patterns
Any of the following correction patterns can be selected.

 z Free Grid (free-form correction)
 z 4 Corner (4-corner correction)
 z Keystone (keystone shape correction)
 z Cylindrical screen (cylindrical shape correction)
 z Elliptical screen (elliptical shape correction)
 z Spherical screen (spherical shape correction)
 z Rotation (rotational correction) 
The Upgrade Kit (ET-UK20) must be applied on the selected projector to enable the Auto Screen Adjustment 
function. 

 “Activation” (page 12)
 z S-shape screen (S-shaped correction)
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4 Corner (4-corner correction)
The positions of the four corners of the image are set with this type of correction.

① ② ⑤ ⑧ ③ ④ ⑥ ⑤ ⑦ ⑨

① Upper Left
Set the horizontal and vertical positions of the upper left.
Setting ranges V (vertical position): 0 to 600 and H (horizontal position): 0 to 600

② Lower Left
Set the horizontal and vertical positions of the lower left.
Setting ranges V (vertical position): -600 to 0 and H (horizontal position): 0 to 600

③ Upper Right
Set the horizontal and vertical positions of the upper right.
Setting ranges V (vertical position): 0 to 600 and H (horizontal position): -600 to 0

④ Lower Right
Set the horizontal and vertical positions of the lower right.
Setting ranges V (vertical position): -600 to 0 and H (horizontal position): -600 to 0

⑤ Reset
Click these to reset the respective settings which have been changed.

⑥ Rotation [degree]*
Set the rotational angle of the image here.
Setting range: Enter a setting from –10.0 to 10.0.

⑦ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑧ Linearity
Set the linearity in the horizontal and vertical directions.
This function can be used only for projectors that have this function.
Setting range: -127 to 127

⑨ Import from CORNER CORRECTION
Reflect the correction results of [CORNER CORRECTION] in the OSD menu of the projector.
This function is available only for models that have the corner correction function in the projector.

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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Keystone (keystone shape correction)
Images are corrected using the keystone shape as the reference with this type of correction.

⑤④②③②①

① Correction pattern adjustment area
The following settings are selected here:

 z Vertical: –45.0 to 45.0*1 (–40.0 to 40.0)*2

 z Horizontal: –40.0 to 40.0*1 (–15.0 to 15.0)*2

 z Vertical balance: –60 to 60
 z Horizontal balance: –30 to 30

The numbers in parentheses serve as the setting ranges if the selected projector has not been activated.

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

② Reset
Use these to reset the settings that have been changed.

③ Setting
The following settings are selected here:

 z Lens Throw Ratio: 0.7 to 16.5
 z V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2

 z H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2

 z V Balance: –60 to 60
 z H Balance: –30 to 30
 z Rotation [degree]*: –10.0 to 10.0

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

④ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤ Import from KEYSTONE
Reflect the correction results of [KEYSTONE] in the OSD menu of the projector.

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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Cylindrical screen (cylindrical shape correction)
Images are corrected using the cylindrical shape as the reference with this type of correction.

⑤④ ⑥②③②①

① Correction pattern adjustment area
The following settings are selected here:

 z Vertical arc: –100 to 100*1 (–50 to 50)*2

 z Horizontal arc: –100 to 100*1 (–50 to 50)*2

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

② Reset
Use these to reset the settings that have been changed.

③ Setting
The following settings are selected here:

 z Lens Throw Ratio: 0.7 to 16.5
 z V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2

 z H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2

 z V Arc: –100 to 100*1 (–50 to 50)*2

 z H Arc: –100 to 100*1 (–50 to 50)*2

 z V Balance: –60 to 60
 z H Balance: –30 to 30
 z Rotation [degree]*: –10.0 to 10.0

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

④ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.
 

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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⑤ Import from CURVED
Reflect the correction results of [CURVED] in the OSD menu of the projector.

⑥ Maintain Aspect Ratio
When a check mark is entered for  , correction is made so that the aspect ratio of the projected 
image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device.
This function can be used only for projectors that have this function.
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Elliptical screen (elliptical shape correction)

Images are corrected to fit a screen whose shape is 
elliptical when viewed from above.

④ ⑤②③②①

① Correction pattern adjustment area
The following settings are selected here:

 z Width/Radius Ratio: 0.01 to 1.20
 z Flattening: 0.50 to 2.00
 z Azimuth: –45.0 to 45.0
 z Vertical balance: –60 to 60

② Reset
Use these to reset the settings that have been changed.
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③ Setting
The following settings are selected here:

 z Lens Throw Ratio: 0.7 to 16.5
 z V Keystone [degree] (Vertical keystone correction): –45.0 to 45.0*1 (–40.0 to 40.0)*2

 z H Keystone [degree] (Horizontal keystone correction): –40.0 to 40.0*1 (–15.0 to 15.0)*2

 z Width/Radius Ratio: 0.01 to 1.20
 z Flattening: 0.50 to 2.00
 z Azimuth: –45.0 to 45.0
 z V Balance: –60 to 60
 z Rotation [degree]*: –10.0 to 10.0

It may not be possible to correct the images depending on how the settings are used in combination, such as a small 
lens throw ratio (lens with a short focus) and keystone correction with a wide angle.

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

④ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤ Maintain Aspect Ratio
When a check mark is entered for  Aspect Ratio, correction is made so that the aspect ratio of the 
projected image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device. 
This function can be used only for projectors that have this function.

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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 � Description of elliptical screen (elliptical shape correction) parameters

View of projector as seen from above

Screen

Tangent Width/Radius Ratio

H Keystone [degree]
FlatteningAzimuth

Projector

Horizontal radius of 
ellipsis

Example of settings

Setting item Calculation method Setting
Lens Throw Ratio Projection distance ÷ width of image on flat screen

= 3 870 mm ÷ 4 300 mm
0.9

H Keystone [degree] Angle formed with tangent of projection center 14.0
Width/Radius Ratio Width of image on flat screen ÷ radius in horizontal direction of ellipsis

= 4 300 mm ÷ 6 200 mm
0.69

Flattening Radius in vertical direction of ellipsis ÷ radius in horizontal direction of ellipsis
= 4 110 mm ÷ 6 200 mm

0.66

Azimuth Position of projected image center on ellipsis 40.0

Screen

Tangent 4 300 mm

14°
4 110 mm

40°

Projector

6 200 mm

3 
87

0 
m

m
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Spherical screen (spherical correction)
Images are corrected using the spherical shape as the reference with this type of correction.

④ ⑤②③②①

① Correction pattern adjustment area
The following settings are selected here:

 z Vertical arc and horizontal arc: –100 to 100*1 (–50 to 50)*2

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

② Reset
Use these to reset the settings that have been changed.

③ Setting
The following settings are selected here:

 z Lens Throw Ratio: 0.7 to 16.5
 z V Keystone [degree]: –45.0 to 45.0*1 (–40.0 to 40.0)*2

 z H Keystone [degree]: –40.0 to 40.0*1 (–15.0 to 15.0)*2

 z V Arc: –100 to 100*1 (–50 to 50)*2

 z V Balance: –60 to 60
 z H Balance: –30 to 30
 z Rotation [degree]*: –10.0 to 10.0

*1   Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2   Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.  

 “Activation” (page 12)

④ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤ Maintain Aspect Ratio
When a check mark is entered for , correction is made so that the aspect ratio of the projected 
image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device. 
This function can be used only for projectors that have this function.

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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Rotation (rotation correction)
Images are rotated with this type of correction.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.

 “Activation” (page 12)

④②③②①

① Correction pattern adjustment area
The following settings are selected here:

 z Gradient: –10.0 to 10.0

② Reset
Use these to reset the settings that have been changed.

③ Setting
The following settings are selected here:

 z Rotation [degree]: –10.0 to 10.0

④ Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.



46

Adjustment and Settings  Geometry Correction

S-shape screen (S-shaped correction)
Images are corrected using an S-shape as the reference with this type of correction.

②①

① Correction pattern adjustment area
The following settings are selected here:

 z S-shaped correction: –127 to 127

② Reset
Use these to reset the settings that have been changed.
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Edge Blending

Edge Blending screen

In addition to the menu items described in “Main menu” (page 19), the following menu items can be used on the Edge 
Blending screen.

 � Edit submenu
Flip Vertical: 

Click to flip vertically the correction status of the entire image.

Flip Horizontal: 
Click to flip horizontally the correction status of the entire image.

①

④

⑤

⑦

⑥

② ⑮③ ⑯

⑰

⑧
⑨
⑩
⑪

⑬
⑫

⑭

① Mode Switching
OFF:
The edge blending settings are canceled.

ON:
Makes the edge blending settings effective.

User: 
Adjusts settings for edge blending using the user-defined curve.
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② Marker
When a check mark is entered in  , markers are displayed in the editing area and on the images projected from 
projector. 
The line at which the edge blending adjustment starts is displayed in yellowish-green, the line for the edge blending width 
is displayed in red, and the line for the black level border width is displayed in yellow.

③ Setting
Click this button to display the user-defined curve setting screen.

 “User-defined curve setting screen” (page 50)

④ Upper
The upper side settings of the projected image are set here.

⑤ Left
The left side settings of the projected image are set here.

⑥ Right
The right side settings of the projected image are set here.

⑦ Lower
The lower side settings of the projected image are set here.

⑧ Enable
Put a check mark is entered in  to create blending settings for that edge. Only the edge blending settings for 
those items with a check mark entered in  take effect.

⑨ Start
The line at which the edge blending adjustment starts is set here.

⑩ Width
The width of the edge blending is set here.

⑪ Black Border (Outside Area)
Set the border width of the black level.
[Outside Area] may be displayed in place of [Black Border] for some models.

⑫ Keystone Area
Set the slope of the black level border when using the edge blending at the same time as the keystone correction. 
This function can be used only for projectors that have this function.

⑬ Overlapped Black Level (Bright Blending)
The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.
Setting range: 0 to 255
[Bright Blending] may be displayed in place of [Overlapped Black Level] for some models.

⑭ Interlocked
When a check mark is entered for  , Overlapped Black Level can be set with the Red, Green and Blue values 
all linked together.

Note
When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the 
Upper, Lower, Left and Right Enable boxes.
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⑮ Non-Overlapped Black Level (Bright Inside)
The black level inside the area where the images are to be superimposed is set here.

When a check mark is removed from  , the Red, Green and Blue values can be set separately.
[Non-Overlapped Black Level] may be displayed in place of [Bright Inside]] for some models.

⑯ Black Border Level (Bright Outside)
Set the black level of the parts where images are superimposed.

When a check mark is removed from  , the Red, Green and Blue values can be set separately.
[Black Border Level] may be displayed in place of [Bright Outside] for some models.

⑰ Editing Area
The edge blending setting status is displayed here.
By dragging these markers, the start position of the edge blending (green), edge blending width (red), and black level 
border width (yellow) can be set.
The settings established with Upper, Left, Right and Lower are also reflected in this area.

Note
The line for the black level border width is displayed only when the mouse cursor is positioned on the yellow marker.

Black level border width(Black Border)
Edge blending width(Width)

Edge blending start position(Start)
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User-defined curve setting screen
When [Setting] is clicked, the user-defined curve setting screen is displayed.
The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.
When a user-defined curve setting is changed from the initial curve, the display above [Setting] changes from [User Blending 
Curve: Default] to [User Blending Curve: Changed].

①

②

④

⑥

⑧

③

⑤

⑦

⑨
⑩

F

A

B

C
D

E

G

H
I

J

① Blending
The position where the user-defined curve is to be set is selected here.

② Copy
Click this to copy the current user-defined curve setting.  
The setting is copied from top to bottom (or vice versa) or from left to right (or vice versa).

③ Gamma
The user-defined curve is set here.
For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).

④ Initial Curve
The initial setting of the user-defined curve is displayed here.

⑤ Correction Curve
The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).

⑥ Store
Click this to reflect the currently displayed user-defined curve setting in the projector and save the setting in the projector.
The setting remains saved even when the main power of the projector has been set to “off”.

⑦ Reset
Click this to reset the currently displayed user-defined curve setting and return it to the initial value.
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⑧ OK
Click this to reflect the user-defined curve setting in the projector and close the user-defined curve screen.

This operation is reflected in the projector even when a check mark has not been entered in .

⑨ Apply
Click this to reflect the user-defined curve setting in the editing area.

This operation is reflected in the projector even if a check mark has not been entered for .

⑩ Cancel
Click this to cancel the setting and close the user-defined curve screen.
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Uniformity
Two correction methods can be used for uniformity.

 � Gradient Correction
This corrects the entire image in the vertical or horizontal direction.
The image is corrected by toning down (removing) the selected colors and using a display with gradations.

 � Flexible Correction
Flexible Correction is enabled by entering a check mark in .
Part of the image is specified, and corrected.

 z From this point onward, the specified area will be referred to as the “target area” and the points where the grids intersect 
in the target area as the “target points”.

The target area and target point can be selected using the same method as for the geometry correction grid.
 “Selecting the control points” (page 32)

A multiple number of target areas can be selected.
Where the target areas overlap, correction will be applied by multiplying the respective settings.
As with the Gradient Correction method, the image is corrected by toning down (removing) the selected colors and 
displaying it using gradations.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector. 
  “Activation” (page 12)
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Correction procedure

1 Click or drag the mouse to select a target point (reference position where the image will be corrected).

The target area is displayed with a red frame around the target point.

2 Adjust the parameter, and establish the settings.

The image is corrected inside the target area centered around the target point.

3 Right-click and select [Area Select], and display the operation points (green) in the target area.

Using the mouse, drag the operation points to enlarge or reduce the size of the target area.
If the mouse cursor is placed between the target area and the target points and then dragged, the target area and target 
points can be moved.

 z [Area Select] can also be selected on the Edit submenu.

4 Right-click to select [Point Select], and release the operation point display.

 z [Point Select] can also be selected on the Edit submenu.

5 When correcting an image in a multiple number of areas, repeat the above steps.

Images cannot be corrected by placing one target point on top of another. It is possible to place one target area on top of 
another.

Target point

Target area

Operation point

Note
[Point Select] and [Area Select] can be toggled by pressing the space key. 



54

Adjustment and Settings  Uniformity

Uniformity screen

In addition to the menu items described in “Main menu” (page 19), the following menu items can be used on the Uniformity 
screen. However, these menu items are valid only when the Flexible Correction method is used for correction.

 � Edit submenu
Reset

Returns the setting to its default value.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.

Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected. 

Area Select
Selects the mode in which the target area is to be moved.
In addition, the target area range can be expanded or reduced while keeping the target points in their original 
positions.

 z [Area Select] cannot be selected concurrently with Point Select.

Point Select
Selects the mode in which the target area and target points are selected.

 z [Point Select] cannot be selected concurrently with Area Select.
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①

⑧

⑩

⑨ ⑪ ⑫ ⑭ ⑬ ⑪

⑮

②③ ④ ⑤ ⑥ ⑦

① Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
z This performs the same operation as [Sub Window] of the View submenu.

② Zoom In
Zooms in to the editing area.
The center of the target area is zoomed in when the target area has been selected in the editing area.

③ Zoom Out
Zooms out the editing area.

④ Editing Area
The target points and target area are selected here, and the color unevenness of the image can be corrected.

⑤ Target Area
In this area, the colors are corrected using the target points as the reference.

⑥ Target Point
These points serve as the reference used for correction.

⑦ Operation Point
Drag these points using the mouse to expand or reduce the target area.



56

Adjustment and Settings  Uniformity

⑧ Enable*
When a check mark is entered in  , the Flexible Correction settings are enabled.

⑨ Gradations
With the target point set to the center, the Red, Green and Blue values are set here.
Setting range: Enter settings from 512 to 1023.

⑩ Interlocked
When a check mark is entered in  , the gradations are set in synchronization with the Red, Green and Blue 
settings.

⑪ Reset
Returns the gradation settings to the default values.

⑫ Store
Reflects the gradation settings in the projector and saves them in the projector.
The settings remain saved even when the main power of the projector has been set to “off”.

⑬ Vertical and Horizontal Gradations
The gradations are set here in the vertical (V) direction or horizontal (H) direction for the entire image.
The gradations are set using the Red, Green, Blue and White colors.

For numerical value input: Enter settings from –127 to 127.
Vertical (V) direction:  Adjusts the slope of the gradation in the vertical direction.
Horizontal (H) direction:  Adjusts the slope of the gradation in the horizontal direction.

How the vertical (V) and horizontal (H) gradation slopes varies depending on the model. For details, refer to the operating 
instructions of the projector.

⑭ Display on PC
When a check mark is entered in  , the vertical and horizontal gradation settings are reflected in the editing 
area. 

The gradation status will not appear in the editing area when there is no check mark entered in . The 
settings will still be reflected in the projector, however. If the Flexible Correction appears in the same area, removing the 

check mark from  will make the editing area easier to see.

⑮ Lamp Statuses
These indicate the lamps that are currently lit on the selected projectors. (Only for projectors that use a lamps as a light 
source.)  [None] is displayed if none of the lamps is lighted.

Right-clicking
If the mouse is right-clicked in the editing area when a check mark has been entered in , the following menu items 
are displayed. The functions of these items are the same as with the Edit submenu items.

 “Edit submenu” (page 54)

Reset
Flip Vertical
Flip Horizontal
Area Select
Point Select

*   This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.  
 “Activation” (page 12)
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Brightness Control
When a single image is configured using a multiple number of projectors, the brightness levels of the images projected from 
the projectors may not be consistent. If this is the case, adjust the projectors so that the brightness levels are made consistent. 
The brightness correction can also be done automatically at periodic intervals.

Brightness Control screen

②

①

③

④

⑤

⑦

⑥

⑧

① The items displayed will vary depending on the projector you are using.

 Brightness Control Gain

This is where the projector brightness is set.  
The brightness of the image projected from the projectors is set according to the numerical value that is set here.

 Operating Mode

This is where the operating mode of the projector is set.
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Normal:
Select this when a high level of brightness is required.

Eco:
This mode produces a lower brightness than in [Normal] mode, but extends the life of the light source.

Long Life1/Long Life2/Long Life3:
These modes produce a lower brightness than in [Eco] mode, but extend the life of the light source.

User1/User2/User3:
These modes allow you to configure separate [Max Light Output Level] and [Light Output] settings.

Max Light Output Level:
This allows you to adjust the upper limit for brightness correction of the screen based on the change in brightness of 
the light source.

Light Output:
This allows you to adjust the brightness of the light source.

For details, refer to the operating instructions of the projector.

② Mode
This is where the brightness correction mode is selected.

OFF:
The brightness is not corrected.

Auto:
The brightness levels of the images projected from the projectors are corrected by the brightness sensors of the 
projectors. 
For details, refer to the operating instructions of the projectors concerned.

PC:
The brightness levels of the images projected from the projectors are corrected using the “Multi Projector Monitoring 
& Control Software”.  
For details, refer to the Operating Instructions of “Multi Projector Monitoring & Control Software.” 

③ Link
This is where the link mode is set.
The mode is enabled when [Auto] has been selected as the Mode setting.

OFF:
The brightness level of the selected projector is corrected.

Group A/Group B/Group C/Group D:
The brightness levels of the projectors in the respective group are corrected.  
The groups are set using the network function of the projectors.  
For details, refer to the operating instructions of the projectors.

④ Calibration Message
When a check mark is entered for  , a message is displayed while measuring the brightness levels for 
correcting the brightness.

⑤ Calibration Time
The time at which to start measuring the brightness levels for correcting the brightness is selected here.

The time can be set when a check mark is entered for .

⑥ Apply
Click this to reflect the brightness control setting in the projector.
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⑦ Status
Brightness correction-related errors are displayed here.

Status Error Description

Red
Brightness sensor error Something is wrong with the brightness sensor (projector).
The brightness cannot be measured. 
Please check the status of the projector.

The brightness cannot be corrected due to a factor that is not 
related to the brightness sensor.

Yellow
The brightness can no longer be 
corrected by a significant margin.

The brightness that can be corrected by the projector is 
reaching its limit.

Green No Error Normal condition.

⑧ Update
Click this button to check the projectors and update the Status displays.
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Color Matching
When configuring a single image using a multiple number of projectors, the coloring of the image projected from the various 
projectors may not be consistent. If this is the case, adjust the projectors to match the coloring.

Color Matching screen

①

②

③

⑤

④

Note
The items that can be adjusted, setting details, and setting range vary depending on the model.

① Mode
The color matching mode is selected here.

OFF
Color matching is not performed.

3 Colors
The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).

7 Colors
The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow 
and White).

709 Mode
The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using 
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
The Target Data values are fixed.
709 Mode cannot be selected for some models. For details, refer to the Operating Instructions of the projector.

Measured
The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using 
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
The Target Data values can be adjusted.
For details, refer to the Operating Instructions of the projector. 
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② 3 Colors
The Red, Green and Blue values are set here.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The White value can be set in addition to the Red, Green and Blue values for some models. 

③ 7 Colors
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here. 
The settings take effect when [7 Colors] has been selected as the Mode setting.

④ Measurement Data
The Black, Red, Green, Blue and White values are set here.
The settings take effect when [709 Mode] or [Measured] has been selected as the Mode setting.

⑤ Target Data
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [Measured] has been selected as the Mode setting.
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Masking
Two kinds of masking are available.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.

 “Activation” (page 12)

 � Line Masking
The shape to be masked is set by moving the operation points on the four sides–top, bottom, left and right–of the projected 
image.
The area to be masked can also be inverted between positive and negative.

 � Bitmap Masking
The bitmap in the 1-bit monochrome format is loaded and set as the masking data.
The position and size of the masking can be changed. 
Bitmaps from 8 × 8 to 1 920 × 1 200 pixels are supported. 
The *.bmp and *.dib file extensions are supported.
The area to be masked can also be inverted between positive and negative.

Note
The Line Masking and Bitmap Masking settings can be used simultaneously. In that case, masking applies to the each area set 
in the settings.

Masking screen

In addition to the menu items described in “Main menu” (page 19), the following menu items can be used on the Masking 
screen.

 � Edit submenu
Reset

When Line Masking has been performed, the positions of the operation points are returned to their initial statuses.
Returns to the status established when the bitmap has been loaded when Bitmap Masking is executed.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

 � View submenu
Mask Marker (Red, Green, Blue, Orange)

Selects whether the operation points are to be displayed or not displayed.
The non-displayed operation points are fixed at the positions when the selection was made not to display them.
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①

⑨

⑧

② ④⑤⑥⑦③

① Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
z This performs the same operation as [Sub Window] of the View submenu.

② Zoom In
Zooms in to the editing area.

③ Zoom Out
Zooms out the editing area.

④ Red
Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
z This performs the same operation as [Mask Marker] – [Red] on the View submenu.

⑤ Blue
Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
z This performs the same operation as [Mask Marker] – [Blue] on the View submenu.

⑥ Green
Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
z This performs the same operation as [Mask Marker] – [Green] on the View submenu.

⑦ Orange
Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.

 z This performs the same operation as [Mask Marker] – [Orange] on the View submenu.
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⑧ Editing Area
Click the operation points to select them, and then drag them to form the shape that is to be masked.  

⑨ Mode Switching
OFF: Masking is not performed.
PC1 / PC2 / PC3: Masking is enabled.

Note
When masking is enabled, only one piece of data (PC) can be saved for some models. 

Note
When the input signal of the projector is changed, retransmission to the projector may be required. 

Right-clicking
Clicking the right-mouse button in the editing area displays a menu with following items. The menu functions are the same 
as with the Edit submenu.

 “Edit submenu” (page 62)

Reset
Flip Vertical
Flip Horizontal
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Line Masking

④③②⑤①

① Left
When a check mark is entered for  , masking based on the operation point on the left side of the projected image is 
enabled.

② Upper
When a check mark is entered for  , masking based on the operation point at the top of the projected image is 
enabled.

③ Right
When a check mark is entered for  , masking based on the operation point on the right side of the projected image 
is enabled.

④ Lower
When a check mark is entered for  , masking based on the operation point at the bottom of the projected image is 
enabled.

⑤ Invert
When a check mark is entered for  , the Line Masking area can be inverted between positive and negative.

Left operation point (Red)

Upper operation point (Blue)

Lower operation point (Orange)

Right operation point (Green)

The operation points at both ends of a side can be moved around the outer circumference (along the four sides) of the 
image.
When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line 
that connects the operation points at both ends of the side.  
When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.
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Bitmap Masking

② ①

① File
Click this button to open the screen on which to select the bitmap data used for masking.
Using the bitmap data which has been loaded, mouse operations can be used to move, enlarge or reduce the masking 
area.
The bitmap data can be moved, enlarged, or reduced in the display area with a resolution of 2 880 × 1 800 pixels. 

If [File] is clicked when the bitmap data for masking has already been loaded, the previously loaded bitmap data is 
discarded and the new loaded bitmap data is set for masking.

② Invert
When a check mark is entered for  , the Bitmap Masking area can be inverted between positive and negative.

Bitmap data (example)

Drag to move.

When the center point here is dragged, the masking area 
can be enlarged or reduced horizontally or vertically.

When a point in one of the four corners is dragged, the 
masking area can be enlarged or reduced without changing 
the aspect ratio.
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Input Signal Adjustments
Projectors normally identify the input signals automatically, but if unstable signals are to be input, this software application 
allows the format matching the input signals to be selected, position adjustments to be made, and so on by manual means.

Input Signal screen

①

②

③

④

⑤

⑧

⑥

⑦

⑨

⑩

① Input Select
These are used to select the input.
Click the input (selector) button of the signals to be projected.
The inputs that can be selected vary depending on the model. 

This operation is reflected in the projector even if a check mark has not been entered for .
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② System Selector
The system format which matches the input signals is selected here.  
The formats which can be selected differ depending on the input signals.

Input Select System Selector
RGB1, Y/C or  
RGB1, Y/C, Video

When the signals use the  
[RGB/YPbPr] format

When the signals use the [Y/C]  
or [Video] format

RGB / VGA60
YCbCr / YPbPr / 480p YCbCr
480p RGB

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60

RGB2 RGB / VGA60
YCbCr / YPbPr / 480p YCbCr
480p RGB

Video Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60

DVI-D RGB
YCbCr / YPbPr

HDMI Auto
RGB
YCbCr / YPbPr

Digital Link Auto
RGB
YCbCr / YPbPr

SDI1 When the signals use the  
[Single Link] format

When the signals use the  
[Dual Link] format

Auto
480i YCbCr
576i YCbCr
720/50p YPbPr
720/60p YPbPr
1035/60i YPbPr
1080/24p YPbPr
1080/24sF YPbPr
1080/25p YPbPr
1080/30p YPbPr
1080/50i YPbPr
1080/60i YPbPr
1080/50p YPbPr
1080/60p YPbPr
1080/24p RGB
1080/24sF RGB
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB

Auto
1080/24p RGB
2K/24p RGB
2K/24p XYZ
1080/24sF RGB
2K/24sF RGB
2K/24sF XYZ
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB
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Input Select System Selector
SDI2 When the signals use the  

[Single Link] format
When the signals use the  

[Dual Link] format

Auto
480i YCbCr
576i YCbCr
720/50p YPbPr
720/60p YPbPr
1035/60i YPbPr
1080/24p YPbPr
1080/24sF YPbPr
1080/25p YPbPr
1080/30p YPbPr
1080/50i YPbPr
1080/60i YPbPr

Auto
1080/24p RGB
2K/24p RGB
2K/24p XYZ
1080/24sF RGB
2K/24sF RGB
2K/24sF XYZ
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB

Note
 z When [Y/C] or [Video] is selected as the RGB 1 Input Setting for RGB In on the Display Option screen, the [RGB1,  
Y/C] and [RGB1, Y/C, Video] system formats will be the same as when [Video] is selected.

 z When [Single Link] has been selected as the SDI Link setting for RGB In on the Display Option screen, different 
[SDI1] and [SDI2] systems are set from when [Dual Link] has been selected.

 z For models that do not support dual link HD-SDI signals, the system format for SDI input is the same as the one for 
[Single Link].

③ Aspect
The aspect ratio of the images is selected here.
The aspect ratios that can be selected are listed below:

 z Default / Auto / VID Auto
 z Through
 z 16:9
 z 4:3
 z H FIT
 z V FIT
 z HV FIT

For details, refer to the operating instructions of the projectors.

④ Clock Phase
Image flickering and contour blurring are adjusted here.
However, they cannot be adjusted when Y/C signals have been selected as the input signals.
Input range: 0 to 31
For details, refer to the operating instructions of the projectors.

⑤ Zoom Mode
The zoom mode is selected here.
The setting is enabled when [Default / Auto / VID Auto] has been selected as the Aspect setting.
The modes that can be selected are listed below:

 z Internal
 z Full

For details, refer to the operating instructions of the projectors.



70

Adjustment and Settings  Input Signal Adjustments

⑥ Vertical (Zoom)
The zoom magnification in the vertical direction is set here.
Input range: 50 to 999

⑦ Horizontal (Zoom)
The zoom magnification in the horizontal direction is set here.
Input range: 50 to 999

⑧ Interlocked
When a check mark is entered for  , the zoom magnification is set with the magnification in both the 
horizontal and vertical directions linked together.

⑨ Vertical (Shift)
The vertical position of the projected image is set here.
Input range: 0 to 4094

⑩ Horizontal (Shift)
The horizontal position of the projected image is set here.
Input range: 0 to 2046

Note
The Input Signal screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon 
menu.
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Projector Menu Settings
Some of the operations using the projector’s menus can be performed using this software application.

Other screen

① ⑤② ③ ④

① Picture
Click to display the Picture screen.
The video mode, black level and other settings related to the image adjustments can be selected.

② Advanced Menu
Click to display the Advanced Menu screen.
The blanking width, input resolution and other settings can be selected.

③ Display Option
Click to display the Display Option screen.
The color correction, aspect ratio and other settings related to the image display used for large screens can be selected.

④ Projector Setup
Click to display the Projector Setup screen.
This enables the projector’s installation position, lamp selection and other hardware settings to be established.

⑤ P in P
Click to display the P in P screen.
The positions and sequence of priority for the main screen and sub screens as well as other P in P functions can be set.



72

Adjustment and Settings  Projector Menu Settings

 � Picture

The following items can be set:

Picture Mode

Note
These items’ settings are reflected in the projector even if a 

check mark has not been entered for .

Contrast
Brightness
Color
Tint
Waveform Monitor

Line Position
Color Temperature

White Balance Red High
White Balance Green High
White Balance Blue High
White Balance Red Low
White Balance Green Low
White Balance Blue Low

Gamma
System Daylight View
Sharpness
Noise Reduction
Dynamic Iris

Auto Iris
Manual Iris
Dynamic Gamma

Dynamic Contrast
Auto Contrast
Manual Intensity
Dynamic Gamma

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the 
operating instructions of the projector. 

Note
The Picture screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
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 � Advanced Menu

The following items can be set:

Digital Cinema Reality
Blanking

Upper
Left
Right
Lower

Input Resolution
Total Dots
Display Dots
Total Lines
Display Lines

Clamp Position
Frame Response
Raster Position

Vertical
Horizontal

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the 
operating instructions of the projector. 

Note
The Advanced Menu screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and 
icon menu.
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 � Display Option

The settings of the items listed below can be established and operated.

Large Screen Correction
Screen Setting

Screen Format
Vertical Position *
Horizontal Position *

Auto Signal
Auto Setup

Mode
Display Dots *
Position Adjust
Signal Level Adjust
Execute

Background Color
Startup Logo
Cut Off

Red
Green
Blue

Shutter Setting
Fade-In
Fade-Out
Startup
Shut-Off

RGB In
RGB1 Input Setting
RGB1 Sync Slice Level
RGB2 Sync Slice Level
RGB2 EDID Mode
RGB2 EDID Resolution
RGB2 EDID V Freq. Scan

DVI-D In
DVI EDID
DVI Signal Level
DVI EDID Mode
DVI EDID Resolution
DVI EDID V Freq. Scan

HDMI In
HDMI Signal Level
HDMI EDID Mode
HDMI EDID Resolution
HDMI EDID V Freq. Scan

Digital Link In
Digital Link Signal Level
Digital Link EDID Mode
Digital Link EDID Resolution
Digital Link EDID V Freq. Scan

Image Rotation

Backup Input Setting
Backup Input Mode
Automatic Switching

Color Correction
Red
Green
Blue
Cyan
Magenta
Yellow

SDI In
SDI Link
SDI1 Signal Level
SDI1 Bit Depth
3G-SDI Mapping
SDI2 Signal Level
Dual Link Signal Level
Dual Link Bit Depth

On-Screen Display
OSD Position
OSD Rotation
OSD Design
OSD Memory
Input Guide
Warning Message

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the 
operating instructions of the projector. 

Note
Items marked with an asterisk (*) cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon 
menu.
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 � Projector Setup

 
The settings of the items listed below can be established and operated.

Projection Method
Cooling Condition
High Altitude Mode
Lamp Select *

Apply
Lamp Relay

Time
No Signal Shut-Off
Standby Mode
Startup Input Select
Date and Time

Time Zone *
Synchronize to PC 
(The projector’s clock setting is synchronized with the computer.)

Note
These items’ settings are reflected in the projector even if a check mark has not been entered for .

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the 
operating instructions of the projector. 

Note
Items marked with an asterisk (*) cannot be reset using the [New All Data] and [New Data (For Current Window)] commands 
on the File submenu and icon menu.
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 � P in P

The following items can be set:

P in P Mode

Note
These items’ settings are reflected in the projector even if a 

check mark has not been entered for .

Frame Lock
Type
Main Window

Input Signal
Size

Interlocked
Vertical
Horizontal

Position
Vertical
Horizontal

Sub Window
Input Signal
Size

Interlocked
Vertical
Horizontal

Position
Vertical
Horizontal

Clock Phase

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the 
operating instructions of the projector. 

Note
The P in P screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
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Auto Screen Adjustment
Applying the ET-CUK10 Auto Screen Adjustment upgrade kit to the projector expands the functions of Geometry Manager Pro, 
and allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the 
screen through use of an externally connected camera.
After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

Note
 z The Auto Screen Adjustment upgrade kit (ET-CUK10) must be applied on the selected projector to enable the Auto Screen 
Adjustment function. 

 “Activation” (page 12)
 z You can check the activation status of the Auto Screen Adjustment plug-in software in [About Geometry…] of the Version 
submenu.

 z To use the Auto Screen Adjustment function, prepare a camera separately.
 z Use a LAN connection when using the Auto Screen Adjustment function.

Preparing Auto Screen Adjustment
 � Projector connection

Use a LAN cable to connect the projector to the computer.

Note
Auto Screen Adjustment cannot be performed via a serial (RS-232C) connection.

 � Camera connection
Use a USB cable to connect the camera to the computer.
For details on supported cameras, check the information found on software download page of the Panasonic website (http://
panasonic.net/avc/projector/pass/).

 � Connection example

Computer

USB connection

LAN connection

Projectors

Camera

Hub

Note
 z If the projector is installed in a portrait orientation, the camera must also be rotated 90 degrees in the same direction as the 
image.

 z Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment 
results. Adjustment is possible when the camera is facing the screen at an angle but may fail if the angle is too large.
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Compatible screens for Auto Screen Adjustment
Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed 
properly, perform adjustments manually.

Compatible screens Non-compatible screens
 z Flat

 z Curved in one direction

Horizontal direction Vertical direction

 z Curve changes smoothly in one direction

S-curve Variable curve type

 z Curved in two directions

Dome type

 z Folded

Folded screen type

Individual adjustments for each side are 
possible.

Operation flow for Auto Screen Adjustment
Settings for Auto Screen Adjustment are configured in a wizard format.

Adjustment items selection

Auto Screen Adjustment complete

Geometry
Edge Blending Color Matching

Auto Screen Adjustment

Projector Layout

Camera Setting

Projection Setting

Projector layout settings

Projector selection and positioning

Camera connection

Camera settings

Screen type settings

Auto Screen Adjustment
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Auto Screen Adjustment procedure
While performing Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to 
check which step you are currently performing.

Progress indicator

Starting Auto Screen Adjustment and selecting the adjustment item

1 Click the [AUTO ADJUST] button in the main screen.

2 Click the items you want to adjust.

Adjustment items selection screen

You can select from three options: [Geometry + Edge Blending + Color Matching], [Geometry + Edge Blending], or [Color 
Matching].

 z The subsequent steps and screens that appear in the procedure will vary depending on the selected items.

Note
 z Make sure the projector is turned on before starting Auto Screen Adjustment. Proper correction will not be possible if the 
projector is in the standby state.

 z When performing color matching (color and brightness correction), do so in an environment where impact from external 
lighting will be low.
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Projector Layout

1 Specify the projector configuration in the projector layout setting screen.

[Restore]

[Height / Width / Stack]

Layout information display area

Projector layout setting screen

1) When you click the [Restore] button and layout information from previously configured projectors exists, the layout 
information is loaded and applied to the layout information display area.

2) Enter the height, width, and stack layout for the projectors in the [Height / Width / Stack] fields.
 z Up to 48 projectors (4 horizontal × 4 vertical × 3 stack) can be configured.

Note
 z You cannot configure a layout that includes more projectors than the total number of connected projectors.
 z If [Geometry + Edge Blending +Color Matching] or [Color Matching] is selected in the adjustment items selection screen, 
configure the layout so that one of height or width is more than one projector.

2 Click [Next].

To return to the previous screen, click [Back].

3 Select the projectors for which to perform correction in the projector selection screen.

[Select All]

[Clear All]

Check boxes

Number of 
selected 
projectors

Projector selection screen

Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
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 z You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking 
the [Clear All] button.

 z If you clicked the [Restore] button in step 1 to load previous layout information, the check boxes for the configured 
projectors will be selected.

Note
 z If the projector configuration includes projectors of different models, Auto Screen Adjustment cannot be performed. Be 
sure to select projectors of the same model.

 z When a projector for which the Auto Screen Adjustment upgrade kit (ET-CUK10) has not been applied is connected, an 
asterisk (*) appears to the left of that projector name.  You cannot select such projectors for Auto Screen Adjustment.   
Perform activation. 

 “Activation” (page 12)

4 Click [Next].

 z To return to the previous screen, click [Back].
 z A warning message will appear if projectors of identical resolutions but different models coexist. Click [Next] to continue 
the process, or click [Cancel] to reselect projectors.

 z An error message will appear in the following cases. 
In such cases, click [OK] and select the projectors again.
- Projectors of different resolutions coexist.
- The number of selected projectors does not match the number of projectors configured in the projector layout setting 

screen in step 1.
- A projector on which the Auto Screen Adjustment upgrade kit (ET-CUK10) has not been applied is selected.

Note
When you click [Next], the geometry correction, edge blending, color, and brightness correction settings of the projectors 
will be initialized.

5 Confirm projector positioning in the projector positioning screen.

Selected projectorsLayout window

[Undo]

[Reset]

[Identify]

Projector positioning screen

Click the layout window to position the projectors.
 z Configure the projectors in order, starting with the first projector in the list of selected projectors. Each number will 
be projected on the screen. Position the projectors in the layout window so that their numbers match the projected 
numbers.

 z Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project 
their numbers on the screen when you click the [Identify] button.

 z You can cancel the positioning of the projector currently being configured by clicking the [Undo] button, or cancel 
positioning for all projectors by clicking the [Reset] button.
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6 Click [Next].

The projector positioning information is saved.
 z To return to the previous screen, click [Back].
 z An error message will appear if positioning of all the projectors is not complete. Configure settings again.

Camera Setting

1 Verify camera connection in the camera connection screen.

[Connect Camera]

Camera connection screen

When you click the [Connect Camera] button, the model name of the camera for which connection is verified appears.
 z An error message appears if connection fails. 
In such cases, click [OK] and check the following.
- The camera is properly connected.
- The camera is turned on.

2 Click [Next].

 z To return to the previous screen, click [Back].

3 Configure the camera you will use in the camera setting screen.

[Test Shot]

Image display window

[Auto Setup]

[Manual Setup]

[White Balance / 
Shutter Speed / 
ISO / F-number]

Camera setting screen

1) Click the [Auto Setup] button.
 z A test pattern appears on the screen, and camera configuration starts automatically.
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 z The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.  
You can select the [Manual Setup] check box to configure the setting values manually.

2) Capture a test shot.
 z A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display 
window. Verify that the entire screen fits within the image display window.

Note
 z To obtain the optimal adjustment results, make sure that the entire screen fills as much of the image display window as 
possible.

 z Adjustment may fail if the entire screen does not fit properly within the image display window.
 z An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and 
configure settings again.

 z If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

4 Click [Next].

 z To return to the previous screen, click [Back].

Projection Setting
   If you selected [Color Matching] in “Starting Auto Screen Adjustment and selecting the adjustment items,” skip to 
step 5 (page 86).

1 Click [Next] in the setting initialization confirmation screen (geometry correction and edge blending).

 z To return to the previous screen, click [Back].

Note
When you click [Next], the projector settings will change to those displayed on this screen.

Setting initialization confirmation screen  
(geometry correction and edge blending)
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2 Configure the screen type and overlap areas in the screen setting screen.

[Reset]

Screen type

Cursor

Screen setting window

Number of cursors

[Edge Blending Width]

[Restore]

Screen setting screen

1) Specify the screen type and number of cursors.
 z Select the screen type that matches the shape of the screen. If [Horizontal Curve] or [Vertical Curve] is selected, 
specify the number of cursors according to the curvature of the screen.
[Flat]: Flat screen
[Horizontal Curve]: Screen that is curved in the horizontal direction
[Vertical Curve]: Screen that is curved in the vertical direction

 z When [Cylindrical-H] or [Cylindrical-V] is selected, you can specify 3 to 32 cursors for each side.
2) While viewing the actual screen, position the cursors in the screen setting window according to the outline of the 

screen.
 z Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard, 
pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the 
Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.

 z You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while 
holding the Shift key.

 z You can also select cursors using the number keys on the keyboard.
 z If a cursor layout that differs from the current one was previously configured, clicking the [Restore] button will 
restore that layout.

 z To return all cursors to their original positions, click [Reset].
3) To configure the horizontal and vertical overlap areas, enter the values in the [Edge Blending Width] fields.

 z You can also use the sliders to specify values.
 z A percentage value that corresponds to the configured pixel count appears in the percent display.
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3 Click [Start].

The projector positioning information is saved.
A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.

 z To return to the previous screen, click [Back].

 z To cancel Auto Screen Adjustment, click [Abort].  
In such cases, click [OK] when the following screen appears.

4 A message indicating that Auto Screen Adjustment is complete appears.

Select [Yes] to save adjustment results to the projectors or [No] to not save.
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 z A message appears if Auto Screen Adjustment fails. In such cases, check the content of the message, click [OK], and 
configure settings again. 
To return to the screen from step 2 (page 84), click [OK].

 z Capture a test shot, and verify that the entire screen 
fits within the image display window. (  page 83)

 z Verify that a large portion of the projected image to be 
adjusted fits within the screen.

 z Check that the camera and screen are as close as 
possible to directly facing each other.

 z Check the position of the image that is projected on 
the screen.

   If you selected [Geometry + Edge Blending] in step 2 of “Starting Auto Screen Adjustment and selecting the 
adjustment items” (page 79), Auto Screen Adjustment is complete.

5 Click [Start] in the setting initialization confirmation screen (color and brightness adjustment).

 z To return to the previous screen, click [Back].

Note
When you click [Start], the projector settings will change to those displayed on this screen.

Setting initialization confirmation screen (color and brightness adjustment)
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A progress bar appears, and Auto Screen Adjustment for color and brightness adjustment starts.

 z To cancel Auto Screen Adjustment, click [Abort].  
In such cases, click [OK] when the following screen appears.

6 A message indicating that Auto Screen Adjustment is complete appears.  
Click [OK] to complete Auto Screen Adjustment.

 z The following message appears if Auto Screen Adjustment could not be completed and must be performed again. 
To perform Auto Screen Adjustment for color and brightness correction again, click [Continue]. To exit Auto Screen 
Adjustment, click [Finish].

 z A message appears if Auto Screen Adjustment fails due to overexposure. 
If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and 
configure settings again.
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Note
 z When you click the  button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment 
appears. 
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

 z The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time 
you configure the settings.

 z To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of 
Geometry Manager Pro.

 “Adjustment and Settings – Geometry Correction” (page 32)
 “Adjustment and Settings – Edge Blending” (page 47)
 “Adjustment and Settings – Brightness Control” (page 57)
 “Adjustment and Settings – Color Matching” (page 60)
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Frequently Asked Questions
Check the following points once more before requesting repair.

Projector is not recognized.

 z Has the projector’s power been turned on?
 z IIs the projector supported by the software application?  “Projectors supported” (page 10)
 z Have the units been connected properly?  “Preparation” (page 10)
 z Has the projector’s network been set up correctly?  “Setting the Projector” (page 11)
 z Has an attempt been made to connect 65 or more projectors?

No connection can be made between my projector and my computer

 z When Windows Firewall has been detected

Windows 7
Is this software registered in [Start] → [Control Panel] → [System and Security] → [Windows Firewall] →[Allowed programs and 
features] tab?
Please register the programs and functions that are approved by firewall in this software.

 z How to set up
1. Click [Start] → [Control Panel].
2. When the <Control Panel> appears, click [System and Security] → [Allow a program through Windows Firewall].
3. When <Allow programs to communicate through Windows Firewall> appears, click [Change settings] → [Allow another program...].
4. When the <Add a Program> dialog box appears, select [Geometry Manager Pro] and click [Add]. 

If [Geometry Manager Pro] is not on the list, click [Browse], select [GeometryGUI.exe] and click [Open]. [Geometry Manager Pro] 
appears in the [Program] column

5. [Geometry Manager Pro] appears in the [Allowed programs and features] column.
6. Select the network from [Home/Work (Private)], [Public] you want to allow connection to and click to select the check box.
7. Click [OK] in the <Allow programs to communicate through Windows Firewall].
8. This software will now be added to the Windows firewall's exception list.

Windows 8 / Windows 8.1
Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel] → [System and Security] → [Windows 
Firewall] → [Allow an app or feature through Windows Firewall] to see if this program is on the list.
Add the software to [Allow an app or feature through Windows Firewall].

 z Adding procedure
1. Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].
2. When the <Control Panel> appears, click [System and Security] → [Allow an app through Windows Firewall].
3. When <Allow apps to communicate through Windows Firewall> appears, click [Change settings] → [Allow another app...].
4. When the <Add an app> dialog box appears, select [Geometry Manager Pro] and click [Add]. 

If [Geometry Manager Pro] is not on the list, click [Browse...], select [GeometryGUI.exe] and click [Open]. [Geometry Manager Pro] 
appears in the [App] column

5. [Geometry Manager Pro] appears in the [Allowed apps and features] column.
6. Select the [Private] or [Public] network you want to allow connection to and click to select the check box.
7. Click [OK] in the <Allow apps to communicate through Windows Firewall>.
8. This software will now be added to the Windows firewall's exception list.

<When another firewall has been detected>
Are any firewall-containing applications installed? 
If any applications which contain firewalls are installed, the installation may not complete. 
(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.
See the User’s Manuals for all applications containing firewalls to perform these settings.
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Messages that appear when an attempt to uninstall or update the software is made

<Is the "Warning 1910. Could not remove ..." message displayed?>
If an NVIDIA driver is installed on the computer, the following message may appear.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start 
up the computer next time. Manually delete the shortcut icons.

Files cannot be saved.

 z Has an attempt been made to save a file that includes values that exceed the range which can be set in the projector?
 z Is there enough free memory on the hard disk?
 z Do you have the authority to access the folder in which the file is to be saved?

Image correction cannot be performed.

 z Have settings been sent to the projector that exceed the range which can be set in the projector?
 z Has the projector’s power been turned on? 
Some items cannot be set if the projector’s power is not on.

 z Are the projector’s input connectors set correctly, and have the correct signals been input? 
Some items cannot be set depending on the input connector settings, the types of signals input and whether or not 
signals are present.

The bitmap used for masking purposes cannot be loaded.

 z Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?
 z Does the bitmap have the appropriate size? 
Bitmaps with a resolution of smaller than 8 × 8 pixels or larger than 1 920 × 1 200 pixels cannot be used for masking.

Cannot connect to the camera (Auto Screen Adjustment).

 z Is the camera turned on?
 z Is the camera connected to the computer properly?

The image does not fit exactly on flat screens (Auto Screen Adjustment).

 z The projected image may not match the edges of the screen exactly if the screen is sagging.  
If the top and bottom edges are off:  
In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the 
shape of the screen.  
If the left and right edges are off: 
In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the 
shape of the screen.

Geometry correction results in an images that appears curved (Auto Screen Adjustment).

 z This occurs on soft curved screens and on screens with heavy sag. 
Correction is performed so that the image appears straight from the point of view of the camera. 
Position to the camera so that it is as close as possible to directly facing the screen.



Note
 z Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
 z Panasonic cannot be held liable for any effects resulting from the use of this software and manuals.
 z Panasonic reserves the right to revise this software specifications and manual contents without notice.

M0414HK1074 -PJ

Trademarks
 z Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.

 z Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the 
respective companies. Note that ® and TM marks are not indicated in the text of this manual.
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